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TX-View 
Instructions for Use 

 

Read this manual before using the TX-View software. 
After reading it, keep it in a safe place for future reference. 
This manual explains you how to install the software and to use it.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

April 2020 Revision 3.72 



Revision History 

Revision Date Description 

3.20 June 2013 First edition 

3.20b July 2013 Supports WX-7000 

3.37 February 2016 Supports VR-24 

3.63 December 2016 Adds real-time display (time/datetime) to horizontal axis (time axis) scale selection 

3.70 April 2018 Changes not to execute with administrator privileges 

3.72 April 2020 Supports Unicode (UTF-8 without BOM) 

   

   

   

   

 

 

 
 
Note: 
 
 
 
 
 
 



TX-View Instructions for Use 
APRIL 2020 Rev. 3.72 

 
 

Page i 

 
 
 
 
 
 
 
 
 
 
 
 

DISCLAIMER 

TEAC disclaims all warranty, either expressed or implied, with respect to this product 

and the accompanying written materials.  In no event shall TEAC be liable for any 

damages whatsoever (including, without limitation, damages for loss of business 

profits, business interruption, loss of business information or other loss) arising out 

of the use of or inability to use this product. 

 

Note 

Any data，including，but not limited to information, describedherein are intended 

only as illustrations of such data and／orinformation and not as the specifications for 

such data and／orinformation. TEAC CORPORATION disclaims any warranty thatany 

use of such data and／or information shall be free from 

infringement of any third party's intellectual property rights orother proprietary 

rights，and further, assumes no liability ofwhatsoever nature in the event of any 

such infringement，orarising from or connected with or related to the use of such 

dataand／or information． 

 

 

◼ Microsoft and Windows are either registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries. 

 

◼ Intel, Pentium and Intel Core are trademarks of Intel Corporation in the U.S. 

and other countries. 

 

◼ TAFFMAT is a registered trademark of TEAC CORPORATION. 

 

◼ Other company names and product names in this document are the 

trademarks or registered trademarks of their respective owners. 

 

◼ Specifications are subject to change without notice. 
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NOTICE TO ALL USERS: 

Any Software is protected by applicable copyright acts and international treaties. Unauthorized reproduction or distribution 
of the SOFTWARE, or any portion of it, may constitute infringement of any rights under applicable civil codes, and further 
criminal behavior, which may result in criminal penalties or damages claimed. 
 
This SOFTWARE is licensed on the condition that YOU agree to all terms and condition of the following End User License 
Agreement. 
 
■End User License Agreement 

This End User License Agreement is an agreement between YOU and TEAC Corporation (hereinafter referred to as "TEAC") 
on the software, including computer programs, online or electronic documents, and if provided, any related record media, 
printed materials, (hereinafter collectively referred to as "SOFTWARE"). By installing the SOFTWARE, it is deemed that YOU 
have agreed to be bound by the terms of this Agreement. In case YOU will not agree to the terms of this Agreement, YOU 
may not be allowed to use the SOFTWARE. 
 

1. GRANT OF LICENSE. 
TEAC grants YOU the right to use the SOFTWARE for the product that YOU possess (hereinafter referred to as "PRODUCT"). 

YOU may produce one set of a duplicate of the SOFTWARE for the purpose of backup. 
 
2. RESTRICTIONS. 
- YOU may not delete the copyright notices or any other proprietary legends on the SOFTWARE, when YOU produce a 

duplicate of the SOFTWARE; 
- YOU may not copy or distribute the SOFTWARE to any third party; 
- YOU may not modify, reverse engineer, decompile, or disassemble the SOFTWARE; 
- YOU may not rent or lease the SOFTWARE to any third party; and 
- Only in case YOU transfer the SOFTWARE together with PRODUCT to the transferee perpetually, YOU may transfer YOUR 

rights under this Agreement to the transferee of the SOFTWARE, provided that the transferee agrees to comply with the 
terms and conditions of this Agreement. 

 
3. TERMINATION. 
YOUR right under this Agreement is extinguished, when YOU dispose of the PRODUCT. Without prejudice to any rights or 
claims to YOU, TEAC may revoke YOUR rights under this Agreement if YOU breach this Agreement. In such event, YOU 
must completely delete the SOFTWARE including any duplicate. 
 
4. COPYRIGHT/TRADEMARK. 
Any and all titles and copyrights in and to the SOFTWARE including any duplicate are reserved to TEAC or the third parties 
who granted license to TEAC (hereinafter referred to as “SUPPLIER”),and are protected by applicable copyright acts, 
intellectual property rights regulations, and international treaties. 
 
5. LIMITED WARRANTY. 
YOU ACKNOWLEDGE AND AGREE THAT ALL INFORMATION SUPPLIED BY TEAC UNDER THIS AGREEMENT, INCLUDING 
WITHOUT LIMITATION, THE SOFTWARE, IS PROVIDED BY TEAC “AS IS” AND WITHOUT WARRANTY OF ANY KIND. TEAC 
HEREBY DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE AND ANY 
MODIFICATION THEREOF BY YOU, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF DESIGN, MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT, OR WARRANTIES ARISING FROM A COURSE OF DEALING, 
USAGE, OR TRADE PRACTICE. TEAC DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL 
MEET YOUR REQUIREMENTS, OR THAT OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR 
THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED, OR THAT YOU WILL HAVE OUR SUPPORT FOR YOUR USE OF 
THE SOFTOWARE. TEAC SHALL HAVE NO RESPONSIBILITY OR LIABILITY FOR ERRORS OR PRODUCT MALFUNCTION 

RESULTING FROM YOUR USE, MODIFICATION, COPYING, OR DISTRIBUTION OF THE SOFTWARE. YOU assume complete 
responsibility for decisions made or actions taken based on information obtained using the Software. Any statements 
concerning the utility of the Software are not to be construed as expressed or implied warranties. 
 
6. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. 
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL TEAC AND THE SUPPLIER BE LIABLE 
FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, DAMAGES FROM LOSS OF OR 
NON-OBTAINING OF BUSINESS INFORMATION OR DATA, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE 
OF OR INABILITY TO USE THE SOFTWARE, EVEN IF TEAC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
IN CASE ANY LAWS OR REGULATIONS IN SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE LIMITATION WILL NOT APPLY TO YOU. 
 
7．MAXIMUMS LIABILITY. 

TEAC’s maximum liability you can claim, if any, under this Agreement shall, in no event, exceed the purchase amount of the 
SOFTWARE paid by YOU. 
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8. MISCELLANEOUS. 
This Agreement shall be construed in accordance with the laws of Japan. All disputes arising in connection with this 
Agreement shall be submitted to the exclusive jurisdiction of the Tokyo District Court of Japan. 
 
Should you have any questions concerning this Agreement, or if you desire to contact TEAC for any reason, please write to 
the address or visit our website set forth below: 
 
TEAC CORPORATION 
1-47 Ochiai, Tama-shi, Tokyo 206-8530, Japan 
TEAC Data Recorder site (Inquiry Form) 
https://datarecorder.jp/en/inquiry/ 
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Chapter 1 Overview 
 

1.1. Introduction 

The TX-View is data viewer software to display the waveform of the data and to extract and store the data, which are recorded with TEAC 
data recorders (*), such as LX-1000 and WX-7000 series. 
 
⚫ As of April 2020, the TX-View supports the data files recorded with the LX-1000/WX-7000/LX-1000/DS/LX series, VR-24, GX-1 

(except for the multi sampling data files) and es8. 
⚫ Types of supporting file formats of conversion destinations are different between those of the DS series and those of the 

LX-1000/WX-7000/LX-100/LX series/GX-1/es8. Refer to “4.2. Converting Data”. 
⚫ This manual is compatible with the TX-View Version 3.72 or later. 
 
Terminology used in this manual: 

“Key”: A push button on the panel of the main unit. 
“Cursor Display”: An item selected in the display and highlighted (called “cursor”) during the main unit operation.  
<MENU>, <Are you sure?>: A message or dialog shown in the unit display or the PC software. 
[REC]: A control button on the unit display or a selection item on the PC software. 
 

 

1.2. What You Can Do 

⚫ View a bulk data recorded by TEAC data recorders: The program can display a maximum of 128 data channels.  If the 
displayed data channels do not fit into a single PC display, you can see them by using a scroll bar.  It reproduces recorded data of a 
selected data file on a T-Y graph from the start point to the stop point data on a single PC display (*), to browse the trend of the data 
file.  Data plot in overlay is also possible.   (*Depends on the installed memory capacity of your PC.  You can use a horizontal 
scroll bar if the data display does not fit into a single PC display.)  

⚫ Extract data, specify the extracting section by browsing a voice memo waveform: The program lets you specify the data 
points to extract data by using two cursors and it can read maximum, minimum, and difference values between the cursors.  You 
can see the voice memo waveform recorded by the LX-1000/WX-7000/LX-100/LX series and VR-24 and then extract by using the 
cursors by listening to your PC. The program can display the event points and information of the data recorded by the 
LX-1000/WX-7000/LX-100/LX-series/VR-24/GX-1/es8.  

⚫ File conversion on the extracted data: The program converts the extracted data to ASCII that general analysis software can 
import, and other file formats (DADiSP, MATLAB, ATI（IDEAS）, WAV, Universal File (UFF58 TEXT), RPC3 and TAFFmat) with 

decimation if necessary.  
⚫ File conversion in batch operation: The program can process a series of pre-registered conversion tasks in batch operation.  You 

can register the series of conversion tasks to a spread sheet list, and you can also save and load them.  
⚫ Processing a waveform data: The program computes the displayed waveform data to FFT and X-Y display. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

TX-View Configuration 

Open files 
■LX-1000/VR-24/WX-7000/LX-100/DS/LX/es8/GX-1 

■Max. 128 channels 

View data 
■Waveform(by channel, overlay), 

Read data by cursor 
■FFT(by channel, overlay) , 

Read data by cursor 
■X-Y(2 channels) 

■Statistics of viewed data 

■RPM value at cursor position data 

Extract data 

■2 cursor lines 

■Search for start/end point by 

selecting Scan, Counter, Time, 
Mark, Level trigger, or pre trigger 

■Link to memo voice file playback 

File format conversion 
■Convert whole or extracted data file 

■ASCII/WAV/MERGE/TAFFmat/ 

Matlab/HeadAcoustic/ATI/ 
UFF/RPC3/EDF 

■Decimation of data 

■Batch processing of multiple files 
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1.3. Important Notice 

Please note the followings on using the software. 
 

 CAUTION 

⚫ The software supports NTFS file format to open and view a bulk data file exceeding 4GB.  
⚫ Depending on the free memory size per the installed memory size of your PC, the horizontal scale of view area will be specified. 
⚫ There is no limitation on the data file size can be opened except for the memory size.  
⚫ The data file size can be converted shall be 2GB or less. 
⚫ The length of memo voice file can be viewed shall be one hour or less.  
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Chapter 2 Software Installation, Launching and Closing Software 
 

2.1. Software Installation 

Required PC specifications 
 

 CPU:     Pentium4 2 GHz or more (Windows Vista or earlier) 
2nd Generation Intel® Core™ i5 3.0GHz or higher (Windows 7 or later) 

Screen Resolution:     1024×768 dpi or better 
Memory:     512 MB or more (Windows Vista or earlier) 

4 GB or more (Windows 7 or later) 
Free space on hard disk:  2 GB or more (Windows Vista or earlier) 
                        10 GB or more (Windows 7 or later) 
CD-ROM drive:    Present (for the program installation) 
OS Requirements:    Windows XP Service Pack3 

Windows Vista Service Pack2 or later 
Windows 7 
Windows 8 
Windows 8.1 
Windows 10 
Windows 11 

 
The version of OS except above listing is out of guaranteed OS for normal operation. 

 

 
⚫ There is no guarantee that, if the PC fulfills the above necessary requirements, it will operate properly. 
⚫ File sizes or the total number of files, which can be handled on PC, may be limited depending on the file systems. 
⚫ The more memory you have, you can view at the wider time scale. 
⚫ Windows sound system to listen to the voice memo  
⚫ A drive to support the type of the recorded media to reproduce the media. 
⚫ CD-ROM drive or equivalent to run the program installation.  
 
 
The installation software is on the CD.  Follow the generic Windows software installation. 

 

1. Insert the installation CD into the drive of the PC.  The installation program 

automatically starts running.  
 

2. If it does not start, run the “setup.exe” on the root directory of the installation CD. 

 

3. Follow the messages displayed. 

 

4. The installation automatically adds an icon to your start up menu.  Program 

installation default is  
\Program Files\TEAC\LXView.exe.  
(However, in case of no optional module.) 
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2.2. Launching and Closing Software 

Follow the generic Windows software operation to launch and close the application. 

1. Double click the icon on your start up menu. 

<Open> dialog is displayed to select a file to view. 
 

2. <Open> file dialog displayed at the launching software is from the previously 

opened folder. 
 

3. Click       on the top right corner or click [Cancel] button to close <Open> file 

dialog. 
 

4. To close the software, click        on the top right corner of the view window or 

click [File] -> [Exit] on the menu bar after closing <Open> dialog. 
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2.3. Open File to View 

 

  
⚫ The software supports NTFS file format to open and view a bulk data file exceeding 4GB.  
⚫ Depending on the free memory size per the installed memory size of your PC, the horizontal scale of view area will be specified. 
⚫ There is no limitation on the data file size can be opened except for the memory size.  
⚫ After opening a file, press Ctrl-Alt-N keys to open the next file recorded with a sequence number in the same folder. 

(e.g.: When the currently open file is LX10_005.dat/hdr, if there is LX10_006.dat/hdr in the same folder, "006" will be opened) 
⚫ After opening a file, press Ctrl-Alt-P keys to open the previous file with a sequence number recorded in the same folder. 

(e.g.: When the currently open file is LX10_005.dat/hdr, if there is LX10_004.dat/hdr in the same folder, "004" will be opened)) 
 

1. Select a file at <Open> dialog appeared at launching the software or click [File] -> 

[Open...] to display <Open> dialog to select the file.  
 
 
 
 
 
 
 
When the file size is more than free size on memory, display the message box. 
Click [Yes(Y)], you can view the time scale corresponding to free memory space. 
Click [No(Y)], you can view the all time scale. (It takes a long time to view the wave.) 
When the file size is more 4GB, you can view the time scale corresponding to 4GB. 
 
 
 
 
 

2. Select the file and click [Open(O)] to display the waveform view window. 
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Chapter 3 Basic Operations at Waveform View Window 
 

3.1. Basic Operations 

The following operations are available at the waveform view window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Open file 

 

Zoom, undo zoom, release zoom 

Export 

Activate the window to 

turn ON/OFF each 
channel display. 

Extend Y-axis by 
dragging the slider to 

downwards 

Click the right edge to change the display horizontal scale. 
scan: Numbers of scans 

second: Elapsed time(Seconds) 
count: Elapsed time display(Hours, minutes, seconds) 

time: Real time display(Hours, minutes, seconds) 

datetime: Real time display(Years, months, days, hours, minutes, seconds) 

 

   Time of C1 cursor     Time of C2 cursor    Time between C1 and C2 curso 

Channel property 
Show details of cursor values of 
each channel 

Time of extreme right of the view window Status bar   Display the operation status Display the current file name with full path 

Display the 
channel number 
name, unit, 

view range 

Show event mark position at event mark number with a vertical line on the graph. 

Copy to Media 

Search bar 
Set parameters to extract data 

Toolbar 

Activate RPM monitor 

PC wave out of a channel data or voice memo           Help 
Activate FFT display         (Version Information) 

Activate X-Y display 
Activate Statistics display 

Display the header information of the file being viewed. 
Display (event) mark list.The button is in-active if no event is 

recorded at the file being viewed 
Display the memo voice waveform window.  The button is 
in-active if no voice memo is recorded at the file being viewed. 

 

Menu bar 
File: Open file, export file (extracting data), Exit 
Edit:  Zoom, undo zoom, release zoom 
View:  Set display properties 
Help:  Version information 

 

Memo voice playback 
They become active when clicking [MEMO] to 
view the voice memo waveform. 

Show maximum/minmum cursor 
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3.2. Use Scroll Bar to Expand and to Move View Area 

Move the slider control located at the right edge of the waveform view window downwards to expand Y-axis scale. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
The size of each scroll bar represents the size of the current display area against the whole data area. 
 

 

3.3. Turn ON/OFF of View Channels 

Click     on the top right corner of the waveform view window to display the channel selection panel to turn ON/OFF of each channel 
display. 

 
 
 

 

 

 

 

 

 

 

 

 

 
Click     again to close the channel selection panel. 
 
 
 

Click each number to turn ON/OFF the correspondent 

channel display. (Gray for OFF) 

Drag the slider control downwards to expand whole Y-axis scale. 
When all channels cannot be viewed by fitting to a single screen, the 

scroll bar will be appeared to move among the channels. 

Click to turn ON all channel display at 
once. Display [DEL], Click to turn OFF 

all channel display. 

Use the left/right scroll bar to move the time scale. 

The scroll bar is not appeared when the data has been fitted into a single screen. 

Click to sort the channel display in ascend order of the channels. 

Click to fit all channels to a single screen. 
If all channel display is not fitted to it due to the display resolution of the 
PC, the software automatically aligns the display to appear the up/down 

scroll bar. 
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3.4. Zoom and Read Data Value by Using Cursors 

Use C1 and C2 cursor to read the data value, and to zoom the view area. 
 
3.4.1. Zoom Time-axis 

1. C1 and C2 cursor are located at the extreme left and right of the waveform view 

window when opening the file. 
 

2. Locate the mouse pointer to the extreme left to change the pointer to <⇔>. 

 

3. Drag the mouse to draw out the C1 cursor and drop at the start zoom point.  

 
 
 
 
 

4. Draw out the C2 cursor as well, to drag and drop at the end zoom point.  

 
 
 
 
 
 
 
 
 
 
 
 
 

5. Click       on the tool bar. 

 

6. Area between cursors will be zoomed. 

 

7. Release the zoom mode to click the following buttons on the tool bar. 

 
      : Returns to previous 
 
 

: Releases zoom 
 
 

3.4.2. Display Cursor Position Data Value 

1. Click         on the bottom of the waveform view window to see the data value 

details by using C1 and C2 cursor. 
 

2. <Wave Parameter> is displayed on the bottom of the window. 

Channel: Displays the channel number. 
Range: Displays the input range setting at recording. 
DispRange(Max)/DispRange(Min): Displays maximu and minimum graph scale value 
in X-axis, which represents as horizontal dot lines.  Maximum and minimum of the 
input range are used as the graph scale default.  They can be specified manually at the 
display range settings of <Channel Property> explained later.  
Cursor(C1)/Cursor(C2) : Data values at C1 and C2 cursor. 
Abs (C1-C2) : Difference between the data values of C1 and C2 cursor. (Absolute value) 
Max (C1-C2) : Maximum data value between C1 and C2 cursor. 
Min (C1-C2) : Minimum data value between C1 and C2 cursor. 
Channel Name: Displays the channel name. 
 
Times of the cursor positions are displayed at the bottom of the window. (Yellow : C1 
time, Green : C2 time, White : Delta-T between C1 and C2) 
 

Area between C1 and C2 cursor can be zoomed. 

Click the right edge to change the display horizontal scale. 
scan: Numbers of scans 

second: Elapsed time(Seconds) 

count: Elapsed time display (Hours, minutes, seconds) 

time: Real time display(Hours, minutes, seconds) 
datetime: Real time display (Years, months, days, hours, minutes, seconds) 
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3. Dragging the left corner of <Wave Parameter> can locate <Wave Parameter> at 

any position of the waveform view window, such as within, left, or top of the window. 
Drag and drop it the bottom of the window to return it to the original position 
 
 
 
 
 
 
 
 
 
 
 

3.5. Overlay View 

View the channels in the overlay mode.  Multiple channels can be overlaid.  
Use <Channel Property> explained later to change the display maximum and minimum scale of Y-axis of each channel. 
 

1. View the waveform display. 

 
 
 
 
 
 
 
 
 
 
 

2. Drag the channel information section located left of the channel waveform display 

to be overlaid to other channel.  The channel information section being dragged turns 
dark gray. 
 
 
 
 
 
 
 
 
 
 

3. Drop it to other channel to overlay view. 

 
 
 
 
 
 
 
 
 
 
 

4. Channel information section of the overlaid channels is changed to the left shown.  

Click X to release the overlay view.  Click < > to change the overlaid channel turns. 
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3.6. Set Graph View Style and Y-axis Scale (Channel Property) 

Use <Channel Property> to change the graph view style and Y-axis display scale. 
 

1. Click        on the bottom of the waveform view window to display <Wave 

Parameter>. 
 
 
 
 
 
 
 
 
 
 
 

2. Double click the mouse button while the mouse pointer is locating at the channel 

row of <Wave Parameter> to open <Channel Property> of that channel. 
 
 
 
 
 
 
 
 
 

 

Item Description 

channel name Displays the channel name set at recording. 

unit Displays the physical unit set at recording. 

range  

range Displays the slope value set at recording. 

offset Displays the offset value set at recording. 

display range Sets Y-axis display scale. 

max Enters the maximum display scale.  Range maximum value set at recording is used as default. 

min Enters the minimum display scale.  Range minimum value set at recording is used as default. 

same Checks “all” and then click it to apply the entered value here to all other channels. 

auto Checks to display in auto range mode by following the maximum and minimum value of the data. 

reset Resets the graph scale entered to the default set at recording. 

all Apply the settings to all other channels after checking it. 

color Selects the colors of the graph line and the background. 

line Selects the graph line color. 

▾ Click to open the color selection pallet. 

same Apply the color selected to all other channels. 

reset Resets the color to default. 

back Selects the graph background color. 

▾ Click to open the color selection pallet. 

same Apply the color selected to all other channels. 

reset Resets the color to default. 

 

 

3.7. Zoom in or out Y-Axis Scale 

Click upper or lower parts of each wave area to zoom in twice or one half times.  

 

       (Zoom in)   (Zoom out) 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



TX-View Instructions for Use 
Chapter 3 Basic Operations at Waveform View Window 

Page 11 

3.8. View Menu 

View Menu 

To turn ON/OFF displaying the tool bar and the status bar, click [View] -> [Toolbar], [Statusbar], [Searchbar]. 
 
Click [View] -> [View property] to display <View property> 
 
<Reset view information whenever importing file> 

If you do not keep the display information whenever closing the software, check the 
box located at the left of it. 

<Set auto range whenever reading file> 
If you set Y-axis scale automatically whenever reading the data file, check the box 
located at the left of it. 

<Use Japanese font> 
If you do not display the Japanese fonts correctly, check the box located at the left of 
it. 

 
⚫ When you select to keep the display information, the information of the channels to be displayed is also kept.  Please note that all 

channels of a newly opened file will not be displayed if the fewer channels have been selected for display. 
 
 

3.9. Browse Contents of Header File 

Click        to browse the contents of the header file. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.10. Check Software Version 

Click        to check the software version. 
 
 
 
 
 
 
 
 
 

Click [OK] to close the display. 
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Chapter 4 Advanced Operations 

 

4.1. Search 

Set the search conditions to extract the part of the data.  The start and end point can be specified. 
 

 
 
⚫ Depending on the memory capacity installed in the PC, the search section may not be displayed on a single screen. 
 

1. Use the buttons locating upper part of the waveform view window. 

 
 
 
 
 
 
 
 

2. Click [Info…] to display the search condition dialog for the following settings. 

There is <Relative> check box available at the dialog at Stop to link the conditions set to 
those set at the dialog at Start.  
 
 
 

 
 
 
 
 
 
 
 
 

Item Description 

Scan Specifies the extracting point with number of scans. 

Counter Specifies the extracting point with the elapsed time from the start recording. 

Time Specifies the extracting point with the absolute time. 

Mark Specifies the extracting point with the (event) mark number. 

Level Trig Extracts the data at a specified signal level change point (level trigger). 
Selects an objective channel and sets a threshold for cross up or cross down. 

Sets the threshold in % or voltage level. 
Sets the pre-trigger points with number of scans or seconds at <Pre Trig>. 

Relative Only for the dialog at Stop: Links to the conditions set at the dialog at Start. 

OK Confirm the entered conditions at the dialog to set for the extracting point. 

CANCEL Cancels the entered conditions to return to previous. 

 

3. Click [Search] to start extracting to view. 

 
 

4.2. Converting Data File 

Click [File] -> [Export...] to display <Export> to convert the data currently being viewed.  The default conversion part is one which is 
currently viewed at the waveform view window.   
In order to convert any part, use the cursor zoom function, or the search function to specify the view part.  
 

 
⚫ Types of supporting file format conversions are different from those of the DS series and those of the LX/GX/es8 series.  
⚫ When newly opening the file to view, the cursors are located at the extreme left and right.  The data in the current view part will be 

converted.  
 
 

4.2.1. Converting Data File Recorded with LX-1000/WX-7000/LX-100/LX series, VR-24, GX-1 and es8 

If the original data file is a data file recorded by a recorder of LX-1000/WX-7000/LX-100/LX series, VR-24, GX-1, and es8 (other than DS 
series), activate “PL-S1002 AFC NEO.” 
When you are using PL-S1002 only, the software does not have any data view function and opens the dialog by executing [AFCNEO.EXE]. 

Click to set the start point of data 

extraction. 

Click to set the end point of data extraction. 

Click to start data extraction. 
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⚫ Use only alphanumeric characters allowed for Windows for a file name and a folder name, do not use Japanese characters. 
⚫ The data file size can be converted shall be 2GB or less. 
⚫ Types of supporting file format conversions are different from the data type. 

SHORT Type TAFFmaｔ/Text/Wav（16bit mono）/Merge（two files）/Matlab/Head Acoustics/ATI/Universal/EDF/RPC3 

 

 DADiSP   DADiSP（TAFFmat） format （.dat/.hdr） 

In the case of GX-1, the data recorded in the multi-sample format is converted 
to the single sample format.  

  ASCII-A/D (TAB)  Text format, A/D value output, TAB delimiter （.txt） 

ASCII-A/D (CSV)  Text format, A/D value output, CSV delimiter （.csv） 

ASCII-A/D (SPACE)  Text format, A/D value output, SPACE delimiter （.txt） 

ASCII-Volt (CSV)  Text format, voltage value output, CSV delimiter （.csv） 

   However, depending on the HDR information, it may be EU (physical) value 
 conversion. 

ASCII-EU (CSV)  Text format, voltage value output, CSV delimiter （.csv） 

16-bit Wave file (mono) 16bit Wave format （.wav） 

   However, only any 1ch in the recording channel is converted. 
Merge   Merge join of two TAFFmat files （.wav） 

Used to combine two synchronously recorded data files into one file. 
TAFFmat   DADiSP（TAFFmat） format （.wav） 

In the case of GX-1, the data recorded in the multi-sample format is converted 
to the multi-sample format. 

MATLAB (Ver.4.x)  Matlab version 4 format （.mat） 

MATLAB (Ver.6.x)  Matlab version 6 format （.mat） 

Head Acoustics  Head Acoustics format （.hdf） 

ATI-Volt (I-DEAS)  I-DEAS voltage value output format （.ati） 

   However, depending on the HDR information, it may be EU (physical) value 
 conversion. 

ATI-EU (I-DEAS)  I-DEAS physical value output format （.ati） 

Universal   UFF58 text format （.uff） 

EDF   EDF format （.rec） 

RPC3   RPC3 format （.tim） 

  

LONG Type TAFFmat/Text/Wav（32bit mono）/Merge（two files）/Matlab 

 

TAFFmat   DADiSP（TAFFmat） format （.dat/.hdr） 

  ASCII-A/D (CSV)  Text format, A/D value output, CSV delimiter （.csv） 

  ASCII-Volt (CSV)  Text format, voltage value output, CSV delimiter （.csv） 

  ASCII-EU (CSV)  Text format, physical value output, CSV delimiter （.csv） 

32-bit Wave file (mono) 32bit Wave format （.wav） 

   However, only any 1ch in the recording channel is converted. 

Merge   Merge join of two TAFFmat files（.wav） 

Used to combine two synchronously recorded data files into one file. 
  MATLAB (Ver.6.x)  Matlab version 6 format （.mat） 

 

1. View the data part to be converted by using the cursor zoom function or the search 

function. 
 

2. Click [File] -> [Export...] on the menu bar or        on the tool bar. 

 

3. <AFC NEO> is displayed. 

While displaying <AFC NEO>, the 
waveform view window will be 
disappeared once, however; it will 
be appeared automatically when 
closing <AFC NEO>. 
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Item Description 

Original file Displays the file to be converted with a full path.  Click [Ref...] to select the data folder. 

Output file Click [Ref...] to set the folder and the file name to save the converted data file. 

From Displays the data conversion start point with number of scans.  Enter the number manually or use the slider control to change the 

start point number. 

to Displays the data conversion end point with number of scans.  Enter the number manually or use the slider control to change the 

start point number. 

Skip Enters a data decimation parameter.  For example, enter [10] if you want decimate the data each one out of 10 scans.  <1/1> 

will be shown if you select the data file format not supported decimation.  

Format type of 
output file 

Selects a file format to convert.  If you select the file format other than one selected at <Output file> -> <Set Output File> <Type 

of File (T)>, the file extension specified at <Output file> is used.  

Channel of original 
file 

<Channel of original file> displays the channels of the original file.  Enter or remove the channel(s) to convert by using [Add all], 

[ADD>>], [<<DEL], [Delete all]. 

Channel of output 
file 

At the default view, it displays all the channels of the original file at <Channel of original file>.  Click the channel and [ADD>>] to 

enter to <Channel of output file> from <Channel of original file>, click the channel and [<<DELL] to delete.  Check [Add all] to 
enter all channels to <Channel of output file> and check [Delete all] to delete them.  The channels displayed at <Channel of 
output file> are those selected at the channel selection panel.  

EXIT Closes the dialog. 

CONVERT Starts converting the selected data part.  <Now converting...> will be shown while conversion.  Click [STOP] to terminate 
conversion.  

BATCH Displays the batch processing menu explained later. 

 

4. Click [Ref...] of <Output File> to display <Set Output File>. 

Set a directory name, a file name, and a type of the file to convert. 
Enter the start ID number at <Start ID Number> to attach to the last of the file name 
entered, and enter the number of digits of ID number at <ID Digits>.  
<TESTLX01.dat> will be created at this example. 
The start ID number and the number of digits will be useful at the batch processing 
explained later. 
The file extension selected at <Format type of output file> is used.  
 
 

5. Set the necessary items at <Set Output File>, and then click [Save(S)] to confirm 

the file name settings.  

 
6. Set other parameters at <AFC NEO>, if necessary. 

 

7. Click [CONVERT] to start the file conversion. 

The processing status of the file conversion is displayed at <Progress bar> on the left of 
[STOP].  Click [STOP] to suspend the conversion.  
 
 
 
 
 
 

 
Merge Data Files 

Merge the data files recorded by using the synchronizing recording function of the LX-1000/WX-7000/LX-100/LX series, VR-24, and GX-1 to 
create a single data file.  

 

 
⚫ 128 channels on a single file is a maximum number of channels for the merge result. 
⚫ At the merge case of the data files recorded at the LX series, the tachometer data channel is treated as data channel, if it sets to ON.  

One tachometer data channel of 16 bits mode will be counted as one channel, one tachometer data channel of 32 bits mode will be 
counted as two channels.  

⚫ The part of the slave data file to be merged follows where the master data file is displayed.  
⚫ The merge function does not support individually selected channels.  

 
 

1. Display the master data file. 
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2. Select and click [Merge] at <Format type of output file> of <AFC NEO> to display 

the slave file selection under <Original file>. 
 

3. Click [Ref…] located the right of the file selection displayed to display <Select File>. 

 

4. Select the slave file at <Select File>, and then click [Open(O)]. 

 

5. The selected slave file is displayed at the file selection.  

 

6. Follow the same procedures of the file conversion to execute the file merge.  

 

 
Batch Processing of File Conversion 
Enter the sequence of the file conversions to convert the multiple files at a time. 

 

1. Click [BATCH] of <AFC NEO>. 

 

2. The batch processing window will be appeared under the file conversion menu.  

 
 
 
 
 
 
 
 
 
 

3. Set a file to convert by following the file conversion procedures explained previously, 

and then click [ADD] to enter the current conversion parameters.  
 

4. You can see the following fields by moving the slider control at the bottom of the 

batch processing window:  
name Name of  <Original file> to be converted 
format File format selected at <Format type of output file> 
ch Channels of the file to convert, being displayed separately by slash symbol 
start Start scan number at <from> 
end End scan number at <to> 
skip Number of decimation at <Skip> 
output Name of <Output file> to convert 
status Shows the progress status of conversion in percentages 
 

 

5. Continually, set the file to convert, and then click [ADD] to enter the conversion 

parameters until you complete the entry of the files to convert.  
 

6. Move the cursor to highlight the file entered, and click [DELETE] to remove it from 

the entry.  The file entered with the check mark removed in the box next to the file 
name will not be processed to convert. 
 

7. Click [ADD MULTI] to display <Select Files>.  Multiple files to be converted can be 

selected by using the standard Windows key operations (Shift key + Arrow key, or Ctrl 
key + right click).  Check [ALL Channels] and [All Data] to make all channels of all 
selected files to the targets for conversion.  Click [Open(O)] to confirm the entry.  
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8. Incremental ID numbers to the file name entered at <Set Output File> will be given 

in the sequence of the file selections.  
 
 
 
 
 
 
 
 
 
 
 
 

9. Click [START] to start the file conversion in batch mode. 

[status] shows the progress status of conversion in percentages. 
Click [STOP] to suspend the file conversion. 
 
 
 
 
 
 
 
 
 
 
 
 

You can save and load the entered file conversion parameters as a parameter file. 
Edit the saved parameter file to easily modify the parameters by using a text editor, and load it to change the file conversion procedures. 
 
Save the entered parameters 

Click [SAVE] to display <Save by changing the file name> dialog to put a file name to be saved. The file extension is fixed at <prm>. 
 
Load the entered parameters 

Click [LOAD] to display <Open file> dialog to load the parameter file previously saved. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
View the contents of entered parameters 

The parameter file shows the entered parameters with texts and comma separated. 

 

 
4.2.2. Converting Data File Recorded at DS Series 

<Export> will be automatically activated to convert the data file recorded at the DS series. 
 

 
⚫ The file type of the target file to convert can be either TAFFmat or Text. 
⚫ Use only alphanumeric characters allowed for Windows for a file name and a folder name, do not use Japanese characters. 
⚫ The data file size can be converted shall be 2GB or less.  
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1. View the data part to be converted by using the cursor zoom function or the search 

function. 
 

2. Click [File] -> [Export...] on the menu bar, or click       on the tool bar. 

 
3. <Export> is displayed. 

 
 
 
 
 
 

 

 

 
Item Description 

Span Selects the part of the data file to be converted with <from> and <to>. 

from Displays the data conversion start point of data conversion.  Enter the number manually to change the point. 
Click [scan] to change to [sec] to set the point in seconds, or reverse to set the point in numbers of scans.  

to Displays the data conversion end point of data conversion.  Enter the number manually to change the point. 
Click [scan] to change to [sec] to set the point in seconds, or reverse to set the point in numbers of scans.  

scan Each click to toggle between [scan] and [sec] to set the start and stop point in either numbers of scans or seconds.  

skip Enter a data decimation parameter.  For example, enter [10] if you want decimate the data each one out of 10 scans.  

Channel The left filed shows the channels of the original file to be converted.  The right field shows the channel to be selected for the file 
to convert.  Enter or remove the channel(s) to convert by using [Add all], [ADD>>], [<<DEL], [Delete all].  

Output Click [Ref...] to set the folder and the file name to save the converted data file. 

Slave Use it to merge the data files recorded at the synchronization recording mode of the DS series. 

Check the box, and click [...] in the right to select the slave data file to be merged. 

OK Starts converting the selected data part.  <Now converting...> will be shown while conversion.  Click [STOP] to terminate 

conversion. 

CANCEL Closes the dialog without conversion. 

 
 

 
About merging data of the DS series 

⚫ You can merge data files to a single file recorded by the synchronization recording function of two sets of the DS units.  (As of 
August 2003)  

⚫ Maximum channel number for the merged data file is 128.  
⚫ The part of the slave data file to be merged follows where the master data file is displayed.  
⚫ The merge function does not support individually selected channels.  
 

 

4.3. Extracting Data with Voice Memo Playback 

With the data recorded with the voice memo recording turned on in the LX-1000/WX-7000/LX-100/LX series, and VR-24, the voice memo 
can be played on the PC and the necessary part of the data can be extracted.  
 
Example: Browse the recorded data file associated with the voice memo in your Windows explorer. 

The voice memo file has the same file name with the data file and the header file. 
*.dat Data file 
*.hdr Header file 
*.wav Voice memo file 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
⚫ Voice memo files to use this function must be shorter than one hour of recordings.  
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1. Open the file with the voice memo recorded with LX-1000/WX-7000/LX-100/LX 

series, and VR-24. 
 

2. Click [View] -> [Memobar], or click        on the tool bar. 

 
If the data file does not have the voice memo file, you cannot operate it. 
 

3. The waveform of the voice memo file will be displayed at the bottom of the 

display(Voice memo waveform window). 
 
 
 
 
 
 

 

 

 

 

 

4. Select the zoom view section on the waveform of the voice memo file by using the 

cursors located at the extreme left and right.  Move a mouse to the cursor position at 

the extreme left to see the cursor pointer change to <⇔>.  Use the left button to drag 

the cursor line to the position of the zoom start point (the left edge).  Use the same 
mouse operation on the cursor located at the extreme right to move the cursor line to 
the zoom end point (the right edge). 
 

 

 

 

 

 

 

 

5. Click       to listen to the voice memo on the specified part by using the  

 
cursors.  The current playback point can be shown in highlight.  Listen to the voice 
memo to check. 
 

 

 

 

 

 

 

6. Click one of the control buttons on the tool bar to stop, play or pause playback. 

Stop, Play, and Pause from left to right.  Release the pause state to click Pause again. 
 
 

 

 

7. Click        to locate the data point of the current pause position to the left edge  

 
the waveform data display.  
 

8. Click        on the tool bar to zoom the waveform data display to specify the data  

 
extracting part according to the current part between two cursors of the voice memo 
waveform. 
 

9. Click        again to close the window. 

 

 

4.4. Move to Event Mark Position by Showing Event Mark List 

You can see a list of events if the event marks are recorded and can zoom the part between the event marks.  
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⚫ No event mark information is recorded at the file recorded by the PC direct recording of the WX-7000/LX series. 
⚫ Depending on the memory capacity installed in the PC, the event section may not be displayed on a single screen. 
 
 

1. Open the file recorded the event marks.  Each event number and its position will 

be displayed on the top of the wave form data display. 
 

2. Click [View] -> [Markbar] or click         on the tool bar. 

 
If the data file has no event mark, you cannot operate it. 
 

3. The list of the event mark numbers and corresponding numbers of scans is 

displayed on the left of the waveform window. 
 
 
 
 
 
 
 
 
 
 
 

4. Locate the mouse pointer to change to <⇔> at a separation line between the event 

mark list and the waveform data display.  Drag the pointer to the right to widen the 
event mark list area to see <COUNTER> and <TIME>. 
 
 
 
 
 
 
 
 
 
 
 

5. Double click the event number on the list to zoom the waveform display to the next 

event number.  You can see the clicked event number data at the extreme left of the 
wave form display and the next event number data at the extreme right of the wave 
form display. 
 

6. Click         again to close the list. 

 
 

4.5. Copy Data to Media 

You can use the copy function to extract the data and copy it to the media which the LX main unit can playback.  
 

  
⚫ No event mark information is recorded at the file recorded by the PC direct recording of the LX series. 
⚫ To create the media playback on the LX main unit, specify the number of channels to be copied within 2, 4, 8, or 8 x according to the 

analog output channels of the LX main unit to be used.  The channel number is automatically selected in ascending order from the 
channels extracted.  

⚫ This function does not support the low speed sampling frequencies of the LX series.  
⚫ The data file recorded other than 96 kHz sampling series of the LX-10F/LX-20/LX-110F/LX-120 can not played back at the 

LX-10/LX110. 
⚫ The function only supports the data file recorded at the LX series. 
 

 
 
 



 

Page 20 

1. Click       on the tool bar 

 
2. <LX Copy> is displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Item Description 

Original Name Indicates the directory name and the file name of the displayed data in a full path.  Click […] on the right to change.  

Span Enters the copy start point to <from> and the copy end point to <to>. 

from Displays the copy start point.  You can manually enter the point to change. 
Click [scan] to change the display to [sec], to set the point either numbers of scans or seconds.  

to Displays the copy end point.  You can manually enter the point to change. 
Click [scan] to change the display to [sec], to set the point either numbers of scans or seconds.  

scan Each click to toggle the display between [scan] and [sec] to specify the point by using either numbers of scans or seconds. 

Sample Displays the sampling rate of the data file.  You can change the sampling rate within the same sampling frequency series when 

creating the copy file.  Refer to the LX main unit instruction manual on the sampling frequency series you can select.  

Channel In the left, the channels of the source file are displayed.  Enter or remove the necessary channels for the copy target file by using 

[Add], [Add All], [Del], or [Del All}. 

Output Sets the copy target file name and the folder name to save by clicking [...] on the right.  

Device Indicates the root directory name of the copy target media. (MO or PC card in your PC)  

Directory Enter the directory name to be used for the data file copy.  The root directory named TEAC_LX is automatically created.  The 

directory you enter is created under the TEAC_LX root directory.  

File Enter the copy target file name.  You can use only up to 8 alphanumeric characters with the extension “.dat” for the file name. 

OK Stars data copy of the specified part. 

CANCEL Close the dialog without copy operation. 
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Note: 
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Chapter 5 View Analyzed Data 

You can see the FFT, X-Y view, or other analyzed results of the waveform display data by clicking the corresponding icons on the menu bar. 

 

5.1. View FFT 

You can see the FFT view of the waveform display data.  This FFT will be valid to the data part of the current displaying waveform.  

1. Click         on the tool bar. 

 

2. <FFT Setup> is displayed.  Select each FFT parameter from the pull down list. 

 

Item Description 

Start Scan Input the start scan point. The default position is the start(left) view one. 
Click to [set] button to set the point using <scan>, <Count>, <Time> and 
<Mark>. 

End Scan Input the end scan point. The default position is the end(right) view one. 
Click to [set] button to set the point using <scan>, <Count>, <Time> and 
<Mark>. 

Spectrum Select the type of the FFTs 
Power/Linear/RMS/PSD(Power Spectrum Density) 

Line Specify the resolution of the frequency axis. 
256/512/1024/2048/4096/8192/16386/32768 
The maximum value is limited by the recorded channel number. 

128ch:2048、64ch:4096、32ch:8192、16ch:16386、8ch or less:32768 

Overlap Select the overlap. 
0%/25%/50%/75% 

Window Select the window function. 
Rectangular/Hanning/Hamming/Kaiser-Bessel/Flat Top 

Because of no amplitude correction, the peak value is calculated low, except 
for [Rectangular]. 

Average Select the averaging method. 
No/Linear/Exponential/Max 

(Average 

Count) 

If the bottom box for average indicates “0”, change the combinations of the 

selected parameters.  It is calculating if there are enough existing data 
points to implement the selected Line/Overlap parameters. 

 

3. Click [OK] of <FFT Setup>. 

  

4. The FFT result of each channel will be displayed. 

 
Click        to change the FFT parameter while displaying. 
 

5. Use the cursors located both extreme left and right of the display by moving to a 

point to read the peak value.  Move the mouse to the cursor position at the extreme 
left to see the cursor pointer change to <⇔>.  Use the left button to drag the C1 
cursor line to the position of the peak point for which you want to read its value.  Use 
the same mouse operation for the cursor located at the extreme right to move the C2 
cursor line to the peak point.  
 
 

6. Click the channel property button           to display values of the C1 cursor and 

the C2 cursor point. 
 

 

 

 

 

 

 

 

7. Double click your mouse cursor at a row of channel information for which you want 

to change the display scales.  This will open <Channel Property>.  
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Item Description 

Channel name Displays the channel name at recording. 

Unit Displays the physical unit at recording. 

x axis/y axis Sets the X and Y-axis scale information. 

Lin Displays at a linear scale. 

Log Displays at a log scale. 

Min Enter a minimum value for the display scale. 

Max Enter a maximum value for the display scale. 

Reset Sets to the default value. 

DC Cut Eliminate the DC component from the display. 

Same Click to apply the current settings to all other channels. 

Color Selects the graph line and back ground color. 

Line Sets the graph line color. 

▾ Click to open the color pallet to select the display color. 

Same Apply the current color to all other channels. 

Reset Sets to the default color. 

Back Sets the back ground line color. 

▾ Click to open the color pallet to select the display color. 

Same Apply the current color to all other channels. 

Reset Sets to the default color. 

 

8. Click [View] -> [1 Wave Monitor] on the menu bar to switch to the waveform 

display.  Click [View] -> [2 FFT Monitor] at the waveform display to return to the FFT.  
 

9. To close the FFT display, click [X] on the top right corner of the FFT display. 

 

 

5.2. View X-Y Graph 

You can select two channels out of the waveform display channels to see their X-Y graph.  

1. Click         on the tool bar. 

 

2. <XY Setup> is displayed.  Select the parameters. 

 

Item Description 

x axis/y axis  

ch Select the channels for X-Y view from the pull down menu. 

max Enter the maximum value for the display scale. 

The default value is the maximum value of each channel. 

min Enter the minimum value for the display scale. 

The default value is the minimum value of each channel. 

Misc  

type Plot type, fixed to [point]. 

signal Select the plot color. 

back Select the back ground color of the X-Y graph.  

 

3. Click [OK] of <XY Setup>. 

 

4. The X-Y graph is displayed. 

 
Click         to change the display parameter during displaying. 
 

5. To read the value of a plot data, use the vertical cursor located at the extreme left 

and the horizontal cursor located at the extreme top.  Cross two cursors at the plot 
data you want to read its value.  Move the mouse to the cursor position at the extreme 
left/top to see the cursor pointer change to <⇔>.  Use the left button to drag the 
cursor line to the position of the point you want to read its value.  The cross point 
values are displayed at the left bottom of the window.  

 

6. Click [View] -> [1 Wave Monitor] on the menu bar to switch to the waveform 

display. Click [View] -> [2 XY Monitor] at the waveform display to return to the X-Y 
graph.  
 

7. To close the X-Y graph, click [X] on the top right corner of the X-Y graph display.  

 
 

Indicates the cursor cross point values. 
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5.3. View Statistical Data 

You can see the statistical data (Maximum, Minimum, Average, and RMS) of the displayed segment.  

1. Click          on the tool bar. 

 

2. <Statistics> is displayed. 

 

3. Click [Save] to output the displayed statistical data as a “csv” file.  

 
 

 

 

 

 
 
 

4. Click [Exit] to close the display. 

 

 

5.4. View RPM Value 

You can see the cursor position data of the selected single channel as RPM (Rotations Per Minute). 
 

 
⚫ This function cannot be used when a large amount of data is displayed on one screen. This function can be used by shortening the 

waveform display time. 
 

1. Click           on the tool bar. 

 
 

2. <RPM Monitor> is displayed. 

 

Item Description 

CAL RPM Click to calculate RPM value. 

Channel 
Selection 

Selects the channel to display its RPM value. 

Cross Up Selects to RPM pulse detection at rising edge.  

Cross Down Selects to RPM pulse detection at falling edge. 

Threshold 
Level 

Specifies the threshold level to detect the RPM pulse.  

Pulse per Rev. Enter number of pulses per revolution. 

Average Enter number of averaging pulses. 

 

3. Click [CAL RPM] to display the RPM value of the current C1 position based on the 

calculation over the current displayed part.  
When the C1 cursor position outstrips the C2 cursor one on the axis of time, display the 
RPM value of the current C2 position. 
 
 
 

 

 

 
 
 
 
 

4. Move the C1 cursor with dragging the mouse to read the RPM values of each cursor 

position.  
 

5. Click         on the tool bar again to close the display. 

 
 



TX-View Instructions for Use 
Chapter 5 View Analyzed Data 

Page 25 

5.5. PC wave out of a channel data or voice memo （WaveOut） 

Reproduce one channel of the data or voice memo on PC. 
 

1. Click        on the tool bar. 

 
 

2. <WaveOut Monitor> is displayed. 

項目 説明 

Channel 

Selection 
Select one channel of the data or voice memo. 

Repeat Check the box, Repeat reproduction in the data part of the current displaying 

waveform. 

Stop button Stop reproduction. 

Play button Start reproduction. 

Pause button Pause reproduction. Release the pause state to click Pause again. 

 

3. The sound reproduction is controlled by the Stop/Play/Pause buttons. 

The P1 cursor show the current reproduction’s point. 
The value in the right window show the current point one. 
 

4. Click         on the tool bar again to close the display. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 

Select one channel of the data or voice memo. 

Stop  Play     Pause 
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Note: 
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Tel. +81-42-356-9161 
Fax. +81-42-356-9185 
 
 


